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Digital technology and the 

ubiquitous camera phone have 

made us all photographers. As fiber 

artists, the 

logical next step 

is to explore 

digital fabric 

printing.

In our eBook 

Digital Quilting 

Designs: Free 

Digital Art 

Techniques for Collage and Quilt, three 

fiber artists show you how to use 

photo-editing software, a printer, and 

surface design to create digital photo 

art.

Margaret Applin is full of Photoshop® 

project ideas. One of her most popular 

techniques is creating digital collages 

using journal pages, paintings, 

textured fabric scraps-anything with 

an interesting design. She walks you 

step-by-step through the process in 

"From Flat to Fabulous with Digital 

Monoprints."

In "From Snapshot to Art Quilt," 

Natalya Aikens shows how to use 

digital art techniques to manipulate 

photos and print them onto fabric. 

By layering them with vintage textiles 

and adding machine and hand 

stitching, you can add a personal, 

handmade touch to your digital photo 

art.

Wen Redmond shows you how to lend 

the texture of an oil painting to digital 

printing on fabric in "Textured Fiber 

Photographs." Her process involves 

spreading a thin layer of molding 

paste onto stabilizer before running it 

through the printer.
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Another digital collage idea from 

Margaret, "Using Digital Imagery 

in Quilting Collages," focuses on 

manipulating your own imagery in 

Photoshop Elements to create stamps, 

Thermofax screens, masks, and 

brushes. Then she shows you how 

to combine the resulting digital quilt 

designs into stitched fiber art.

With these artists and their digital art 

techniques to guide you, there is no 

limit to the art you can create.

Warmly,

 

Vivika Hansen DeNegre 

Editorial Director

Take Quilting Daily 
 on the go

with the FREE Mobile app for 
your iPhone or iPod Touch.

A swipe of your fi nger 
gives you access to:
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patterns, and eBooks
 Over 100 how-to videos
  Tips and techniques from 
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*Apple, iPad, iPhone, iPod touch, and iTunes are trademarks of Apple Inc., 
registered in the U.S. and other countries. App Store is a service mark of 
Apple Inc. Non-US residents: if the above link does not work for you, feel free 
to browse our selection of Apps from within the Apple App Store itself by 
searching for “Interweave”.

*Apple, iPad, iPhone, iPod touch, and iTunes are trademarks of Apple Inc., 

Get your FREE 
Quilting Daily app at

www.QuiltingDaily.com/app
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FROM flat 
                    TO fabulous 
                                WITH     DIGITAL MONOPRINTS 

by Margaret Applin

Adapted from 
Quilting Arts Magazine 
October/November 2011
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items to use for 
digital collage
Select a variety of these items from 
your own artwork:

•	Journal pages (finished or 
unfinished)

•	Existing textured or patterned 
backgrounds 

•	Existing monoprints 

•	Fabric scraps with lots of texture

•	Simple hand-drawn shapes or 
silhouettes

•	Watercolor paintings or other 
paintings

•	Copyright-free photographs

When I monoprint, I use a variety of organic forms, stencils, 
and texture tools. However, as much as I enjoy the tech­

nique, my monoprinting results sometimes leave me feeling flat 
and I find myself reaching for more: more depth, more mystery, 
more layers. But with digital monoprinting, the textures and 
patterns that I love working with on paper or fabric can be trans­
formed and maximized to create the basis for dimensional imagery 
for my fiber art. My digital monoprints are a blend of marks I have 
made on paper and fabric (in color and black and white), fused to­
gether within a digital design environment. Best of all, I don’t spill 
any paint in the process!

M A T E R I A L S

•	 Photo-editing software

•	 A selection of items to use as layers in 
your digital collage (see “Items to use 
for Digital Collage”)

•	 Ink-jet printer fabric sheets 

•	 Printer 

•	 Fabric, batting, paints, and 
embellishments as desired (to 
complete the quilt)

Directions
Creating a digital 
monoprint
1.	 Select a variety of items to 

incorporate into your digital 

collage, and scan or upload them 

into your computer. 

2.	 Open your photo-editing software. 

(I use Adobe® Photoshop® 

Elements 7, so these instructions 

are specific to that software; adjust 

as necessary for the program you’re 

using.) Create a new file set at 

300 dpi with a white background. 

(I prefer to work in a square-

shaped layout, but any shape or 

orientation will work.) 

3.	 Save and name your file. I always 

add “recipe” onto the end of 

the file name so I know it is the 

version with all the layers. 

4.	 One-by-one, open up each image 

and drag it onto the new file in any 

order. When a layer is selected, 

you can resize, rotate, flip, or shift 

your image to place it exactly 

where you want it.

5.	 Experiment by moving the layers 

around and manipulating the look 

and feel with blending modes and 

filters until you are happy with 

the design. Read “Creating ‘Indian 

Summer’ Digital Monoprint” to 

learn the specific steps I used to 

create that particular digital image.

NOTE: This process is highly addictive 

and equally frustrating until you get 

the hang of the effects of the blending 

modes. Your image layout can change 

dramatically with the smallest 

adjustment, or it may not change at all 

when you expect it to. You can always 

“undo,” so there is no need to panic, but 

always remember to save your work.

6.	 When you have completed your 

monoprint design, duplicate the 

file, rename it so you do not write 

over the original “recipe” file, 

and then flatten the image before 

you print it. (You always have the 

option of starting all over again 

using the flattened image!) 
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Creating 
‘Indian Summer’ 
Digital 
Monoprint

Process images by Margaret Applin

For “Indian 

Summer”  

(14" × 13") I 

combined three 

elements: a gelatin 

monoprint on 

paper, a section 

from a larger 

collage, and a 

photograph of a 

tropical leaf that 

I had previously 

transformed to 

a Photoshop 

Elements brush 

(below).
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Within Photoshop Elements, these 

images were added as layers and then 

further manipulated with adjustments 

and blending modes to create the final 

image that was printed to fabric and 

incorporated into the quilted wall 

hanging. (Additional manipulations 

were created prior to the completion 

of the final design that are not 

outlined here.) Through the following 

steps, you can see how the layers were 

applied and manipulated to get to the 

look and feel of the final print.

1.	 I started this design using the image 

of the collage as the background. 

(Figure 1) (I recommend that 

you not use an image as the 

background, as I did here, but 

instead create a new file set at 300 

dpi with a white background per 

the instructions for “Creating a 

Digital Monoprint.”) 

2.	 Because I started my file with an 

image as the background, I had 

to turn off the background layer. 

(Figure 2)

3.	 The gelatin monoprint became my 

bottom layer. (Figure 3)

4.	 Next, I created a fill layer using a 

solid color selected from the color 

picker tool. On this layer, I selected 

the “Multiply” blending mode 

from the drop-down selection. This 

step allowed the color to penetrate 

everything below it. (Figure 4)

5.	 At this point, I duplicated a 

copy of my background image to 

incorporate into the layers. (To 

turn the layer on, click on the 

box immediately to the left of the 

image. You will see the eye image 

letting you know that it is visible.) 

On this layer, I selected the “Soft 

Light” blending mode and then I 

rotated the image 180˚. (Figure 5)

6.	 Prior to adding the tropical leaf 

brush to my file, I had created a 

separate file using my brush as a 

mask on a different background. I 

grouped the layers and then when 

I flattened the file and saved it, the 

color remained. This is the image 

that I used within this design. 

(Figure 6)

7.	 When I applied the first leaf layer, 

I shifted it all the way over to the 

left, hanging off the edge. On this 

layer, I selected the “Color Burn” 

blending mode. (Figure 7)

8.	 I duplicated the leaf texture layer 

and dragged it over to the right 

side and left it hanging off the 

edge. I also flipped this image 

horizontally so the direction of the 

vein was opposite the other layer. 

On this layer, I selected the “Soft 

Light” blending mode. You can 

see how the background of each 

leaf layer is white. I used this to 

my advantage to split the shading 

on the two sides of my design. 

(Figure 8)

9.	 For the purposes of this 

demonstration, I shut off the 

bottom layer to illustrate how the 

“Color Burn” on the left and the 

“Soft Light” on the right appear. 

The main edge that you see in 

the middle was positioned to 

fall right along the stem of the 

bottom layered image. Using the 

eraser tool set at 15% opacity and 

selecting the leaf texture duplicate 

layer, I touched up the edge that 

had formed due to the overlap of 

the two leaf texture layers to make 

it fade out. I applied the eraser at 
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both the top and bottom of the 

edge. (By using a lower opacity to 

erase, you can apply it more with 

very subtle changes at each mouse 

click. This allows for much better 

blending of the edge.) I did not 

do any touch-up erasing along the 

very middle of the edge. (Figure 9)

10.	The last step of this design was 

the addition of a photo filter 

adjustment. I selected Sepia at a 

30% density.  

(Figure 10)

11.	Next, I duplicated my file, renamed 

it so I would not write over the 

original “recipe” file, and then 

flattened the image. (Figure 11) 

Then I started all over again using 

the flattened image. After this 

second level of manipulations and 

adjustments, I printed the final 

image to a silk habotai ink-jet 

printer fabric sheet.

Create  
the quilt
1.	 Print your digital monoprint onto 

an ink-jet printer fabric sheet. 

Once the image is dry, heat set it 

with an iron. (Another option is to 

print your digital monoprint onto 

paper and then transfer it onto the 

fabric of your choice using  

iron-on transfer paper.) For 

“Indian Summer” I printed my 

digital monoprint onto a piece of 

silk habotai ink-jet printer fabric.

2.	 Incorporate your digital monoprint 

into a quilt. You can simply 

sandwich the printed fabric, quilt, 

bind, and embellish as desired. Or 

you can combine the monoprint 

with additional fabrics and 

make a larger piece. For “Indian 

Summer,” I layered the printed 

fabric on pieces of coffee-stained 

cotton batting and then quilted 

the piece. Next, I painted it using 

acrylic paint and a brayer. I added 

some Lumiere® metallic paint 

to highlight certain areas. The 

embellishments are copper-colored 

beads and heavy-duty copper wire 

attached with thread to the edges 

of the wall hanging. 

margaretapplindesigns.com

helpful guidelines for  
           digital collage
•	Pay attention to what layer you are 

on while making adjustments. You 
may think you are making a specific 
adjustment and you don’t see the 
results you want because you have a 
different layer selected.

•	Use the “Undo” and “Redo” buttons 
as you make adjustments to see if 
you really like the changes you made 
before continuing.

•	During the design process, if you 
love a particular result you have 
created, duplicate it and save it as 
its own file; then continue working 
on your main file. That way, if you 
are unhappy with the results after 
further manipulation you can go 
back to the part you especially 
liked. (I do this so frequently that 
I have numerous versions of that 
one design layout. I find that I 
will go back to one of my saved 
files to begin a new design using 

different color schemes or additional 
textures.)

•	Blending modes are like chemistry. 
Learn to anticipate the results of 
certain modes by experimenting and 
playing.

•	When you start to build your digital 
design files, it helps to be very 
organized. Create a file-naming 
convention or different folders for 
your backgrounds, brushes, etc. 
Before you realize it, you will have 
collected a number of images that 
you will be searching through for a 
design.

•	If you are sure of a design that 
you want to print out, save it as 
a duplicate with a new file name 
(“xxxx-final”) and use that smaller 
file for printing. Save your original 
design with all of the layers as your 
“recipe” file. 
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FROM SNAPSHOT  

         TO art quilt by Natalya Aikens

“St. Pete Lace 2” • 12" × 12" (left),  
   “St. Pete Lace 4” • 12" × 12" (right)

Adapted from 
Quilting Arts Magazine 
December 2011/January 2012
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“St. Pete Lace 4” • 12" × 12"

M A T E R I A L S

•	 Adobe® Photoshop® Elements or 
photo-editing software of your choice

•	 Photos

•	 Fabric 

•	 Sewing machine with free-motion 
capabilities

•	 Thread

•	 Needle and thread for hand sewing

Optional 

•	 Transfer Artist Paper™ (TAP)

•	 Organza

•	 Sheers

•	 Vintage fabric, lace, or recycled fibers 
(I use dryer sheets.)

•	 Tear-away stabilizer

•	 Freezer paper

•	 Wooden frame or stretched c anvas

Ienjoy photographing architecture during my travels and often 
use my photos to make artwork. My process involves manipu­

lating photos in Photoshop so I can print the images on various 
materials. I then layer the images with vintage textiles and recy­
clables in my stash, thread sketch with my trusty Bernina® sewing 
machine, and add lots of hand stitching. 
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Directions
Select and save  
your photo
1.	 Select a photo to use in Photoshop 

or the photo-editing software 

of your choice. Some points to 

consider when selecting a photo 

are the crispness of the shot, visual 

interest, and resolution.

2.	 Open Photoshop and then open 

your photo. Select “Save As” and 

save the image in its own folder 

and name it. You can name the 

image file anything. For example, 

“fence original.jpg” will do. Save 

the photo in the format that it is 

in, whether it is a jpeg, a tiff, or a 

raw file. 

3.	 Once you have your image saved, 

decide if you need to crop the 

photo. Make sure the rulers are 

visible on the sides of your photo. 

Go to “View” and make sure there 

is a check mark next to the word 

“Rulers.” Use the “Crop” tool and 

crop your image.

4.	 Next, size your photo. It is best 

to keep the file large from the 

beginning, as you can always make 

it smaller later. But if you know 

you’d like to work small, then size 

it close to what your final project 

will be. 

5.	 Save your correctly sized photo 

by clicking “Save As” and adding 

something like “sized” to the title 

of the photo.



“Piter’s Rooftops 1” • 20" × 20"
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Alter your photo
Now that you have sized and saved 

your image, playtime can begin. 

1.	 Get started by playing with 

the “Enhance” feature and 

select Enhance>Adjust 

Lighting>Brightness/Contrast, 

or Shadows/Highlights and 

Enhance>Adjust Color>Adjust 

Hue/Saturation. Sometimes just a 

few adjustments are all you need to 

add a fun, new look to your photo. 

2.	 Once you have adjusted the photo 

to the look you like, save your 

photo with a new name. Add 

something descriptive to the title, 

like “hue.” Save several variations 

of your photo if you can’t make up 

your mind, or if you decide you 

want to do a whole series.

3.	 Next, play with the filters. You 

can do just a bit of transformation 

by using filters such as “Colored 

Pencil,” “Smudge Stick,” and 

“Poster Edges.” Or you can go 

radical by using filters like “Palette 

Knife,” “Sumi-e,” “Chalk & 

Charcoal,” and “Stamp.” Explore 

and try to find a filter you like 

and make sure that you save each 

individual variation as you work. 

4.	 Continue to experiment with a 

variety of tools to achieve the look 

and feel you want for your image. 

For more information on some 

of the tools I use in my work, see 

“Photoshop Tools.”

Layer images
The next step is to experiment with 

layering images to add depth to your 

work. 

1.	 If you want to layer two images 

exactly one over the other, first 

make sure they are the same 

resolution and size. 

2.	 Using the “Move” tool, click and 

drag one image on top of the other 

(from one photo to the other 

photo). You need to have both 

photos open on your screen in 

order to do this. 

3.	 Once the images are in one 

document, adjust the opacity of 

each image and decide how much 

you want to see of the image 

underneath. In the little side panel 

where you see your layers is a 

window that says “Opacity 100%.” 

Click on the arrow next to the 100 

and adjust down. 

TIP: If you prefer to skip the layering 

in Photoshop, you can still achieve a 

layered effect by printing two different 

images on sheer fabric (or one on a 

sheer and one on a solid) and layering 

them when stitching.



“St. Pete Lace 13” • 15" × 15" 

  image transfer
What if there is no way to get your 
chosen fabric through the printer? 
Say it’s a vintage textile or has way 
too much texture. Here are two 
methods I use to transfer images to 
my quilts.

ORGANZA Printing your image on 
organza and then layering it over 
your fabric of choice is one way 
to get your image onto your quilt. 
You can combine several layers of 
organza and translucent papers for 
some lovely ethereal effects, or trap 
sheer scraps between your organza 
layers and place netting on top to 
secure them in place.

TRANSFER ARTIST PAPER 
Another method is TAP (Transfer 
Artist Paper). TAP is a heat transfer 
method using special paper. TAP 
can be used to transfer a stamp-like 
image. To use TAP, make your image 
one color (usually black), print the 
mirror image of it onto TAP paper, 
cut and scrape away parts of the 
design, and then make the transfer. 
This method takes a bit of elbow 
grease, but is well worth the effort.
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Put it all together
There are many ways to bring your 

piece together. One of my favorite 

ways to stitch on my art quilts is to do 

a little bit of thread painting with my 

sewing machine first. Then I add hand 

stitching, using the versatile straight 

stitch. It is amazing what subtle effects 

can be achieved with variegated thread 

and a needle. Here are the steps I use 

to finish my art quilts.

1.	 Print your fabric on sheers to be 

layered and overlapped on the 

edges. The easiest way to print 

your image on fabric is to buy 

prepared 81/2" × 11" fabric sheets. 

They come in a few different types 

of fabric including organza, silk, 

and cotton. Most printers have no 

trouble printing on these. You can 

also get sheets of freezer paper and 

iron your chosen fabric onto them. 

In this case, remember to make 

sure your fabric edges are trimmed 

perfectly; you wouldn’t want your 

printer to get upset. You can also 

print onto dryer sheets by first 

ironing them onto freezer paper. If 

you have a more advanced printer 

that accepts rolls of paper, you can 

buy various fabrics on a roll.

TIP: Vintage linens and lace will not go 

through the printer, but you can print 

your image on organza and layer it over 

vintage fabrics, or trap lace between 

printed sheers. For more ideas, see 

“Image Transfer.”
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2.	 There are two options when adding 

machine stitching. You can add 

machine stitching using tear-away 

stabilizer underneath the sheers 

to prevent a puckered effect. Or, 

if you prefer a puckered, textured 

look, you can piece sheer panels 

together using a French seam for 

a lovely, clean finish. Then thread 

sketch with your sewing machine 

without stabilizer in order to 

purposefully pucker the material. 

3.	 Once the machine stitching has 

been added, use hand stitching 

to emphasize areas of the image. 

If you didn’t use stabilizer while 

stitching, hand stitching can help 

bring those puckers back under 

control and create a whole lot of 

texture in the process. A plain 

straight stitch will add a subtle 

effect to your quilt when using 

variegated thread. 

4.	 Finish, bind, or mount your quilt 

as desired.

There are many tools available in 

Photoshop to alter your photo. Here 

are some of my favorites. 

Eraser
When layering multiple images you 

can use the “Eraser” tool to erase 

portions of the top image so the one 

underneath can peek through. Simply 

increase or decrease the size of your 

eraser by selecting brush size.

Magic Wand 
If you’d like to remove a portion of 

your image, the “Magic Wand” can 

32

4

1

3
1. Eraser; 2. Magic Wand; 3. Rectangular Marquee; 4. Paint Bucket

Photoshop tools
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live up to its name. When you click 

on an area with the Magic Wand, it 

selects all pixels that have the same 

color as the pixel you clicked on. For 

example, if there is a large single color 

area that you want to remove, click on 

the middle of it and it will select most 

of the area. Hold down the shift key as 

you select more areas. When you have 

a section you are ready to remove, go 

to Edit>Delete. If you have selected an 

area by mistake, click Edit>Undo. If 

you want to stop and deselect all that 

the Magic Wand has selected, go to 

Select>Deselect.

Rectangular Marquee
If you have a large multicolored area 

that you want to get rid of, or if you 

want to get rid of small rectangles 

or ovals in your photo, use the 

“Rectangular Marquee” tool. Click 

on your photo and drag the rectangle 

to the size you want. Then choose 

Edit>Delete. You can switch from 

the “Rectangle” to the “Elliptical 

Marquee” by holding your cursor over 

the little triangle in the corner of the 

“Marquee” tool.

Paint Bucket
The “Paint Bucket” tool is handy 

when you want to replace a color with 

another color. Use the “Eyedropper” 

tool first to select a color from the 

palette panel or from another area of 

your photo, then click on the Paint 

Bucket tool. Bring the paint bucket 

over the area where you want to 

replace color and click. All the similar 

color pixels will fill with the new 

color. Alternatively, you can select an 

area with the Rectangular Marquee 

tool, switch to the bucket, and fill that 

perfect rectangle or circle.

Free Transform 
“Free Transform” is also fun to 

play with, especially if you have a 

single element in your photo that 

you would like to transform. Select 

that element first with the Magic 

Wand, switch back to the Move tool, 

then go to Image>Transform>Free 

Transform. A square or a rectangle 

will appear around your element. Tug 

at its corners, or sides, or turn it to 

transform your photo. Click “Enter” 

on your keyboard to complete the 

transformation.

TIP: Remember that you can always 

switch the order of your layers by 

dragging a layer up or down in the 

panel to switch around. By using the 

“Move” tool you can also move your 

images around and align different 

portions of the photos. Whatever you do, 

just remember to “Save As” while you 

are working. 

artbynatalya.com
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TEXTURED FIBER 

photographs

by Wen Redmond

Adapted from 
Quilting Arts Magazine 
February/March 2012
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Directions
Prepare the base 
1.	 Begin by covering your work 

surface with a plastic drop cloth.

2.	 Cut your stabilizer base to your 

desired size and place it on your 

work surface. (To become familiar 

with this technique, you may want 

to start with a small sample.)

3.	 Use an old credit card or a palette 

knife and spread a thin layer of 

molding paste onto the stabilizer. 

You may simulate brushstrokes 

or texture the molding paste with 

stamps or sticks. For my sample, 

I pressed cheesecloth into a small 

area. (Figure 1)

TIP: The texture of the molding paste 

shouldn’t be higher than the thickness 

of a penny or it will jam in the printer 

later. However, if your molding paste 

dries too thick you can use sandpaper to 

reduce the thickness. 

4.	 Continue to texture the paste so 

that it suits the texture in your 

photograph. Consider the effect 

you want to achieve. Think about 

oil paintings and the look of their 

textured brushstokes. You may 

want a lot of texture for some 

photographic images, such as an 

old wall or landscape, or you may 

want just a touch of texture to add 

interest to the background of a 

portrait. Allow it to dry until tacky.  

5.	 Apply a thin wash of acrylic paint 

on top of the dry molding paste 

to accent the texture. (Molding 

paste accepts paint well.) Adding a 

wash of paint will create additional 

color accents and highlights in 

your finished printed photograph, 

especially if the image is black and 

white or light in tone. To create an 

acrylic wash, dilute your acrylic 

paint with water, in a 1-to-1 ratio. 

Be sure your wash is light in hue 

so that your photograph will 

show up when you print it on the 

molding paste. Allow the paint to 

dry completely. (Figure 2)

M A T E R I A L S 

•	 Stabilizer, medium to firm (I use a 
rayon/polyester cut-away stabilizer.)

•	 Plastic drop cloth  

•	 Lightweight molding paste

•	 Spreader (old credit cards or palette 
knife)

•	 Glue stick or double-stick tape

•	 Acrylic paint of your choice, 1 or 2 
colors

•	 Paintbrush

•	 Rotary cutter and mat

•	 Scissors

•	 Photo 

•	 Photo-editing software of your choice

•	 Printer with pigment ink (I use an 
Epson® printer with DURABrite Ultra™ 
inks or UltraChrome™ inks (These inks 
are both fade- and water-resistant.)

•	 Printer paper

•	 Varnish

•	 Foam brush

Optional

•	 Stamps, sticks, or cheesecloth for 
additional texture

•	 Sandpaper

Printing a photo on a textured background lends an unusual 
dimension to fiber art. My process involves spreading light­

weight molding paste onto a stabilizer base. The molding-paste 
base, or substrate, can then be painted and fed into a printer to 
create a painterly photo thin enough to be sewn and manipulated. 
This technique works with most photographs and is inspired by 
the textured brushstrokes of an oil painting. 

Process photos by Wen Redmond

Figure 1
Previous page: “Pause” • 32" × 25"
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NOTE: Metallic washes work well 

because they settle into the nooks and 

crannies of the molding paste and will 

highlight your final image. 

Print the image
1.	 While you wait for the paint on 

your molding paste to dry, prepare 

your digital photograph. 

2.	 Size your photograph in the  

photo-editing software of your 

choice. You can divide the image 

into a triptych, as I did in the piece 

shown on the next page, or use 

the image as is. There are many 

effects you can achieve with the 

techniques and tools available 

through  

photo-editing software. Let your 

creativity flourish. 

3.	 In order to get a full-bleed effect or 

a print that covers the edges (as in 

my image), print your photo using 

the Microsoft® Word program. 

Setting it up in Word will allow 

your printer to output the image 

exactly where you have placed the 

molding paste substrate. 

4.	 Insert your picture into your Word 

file. In order to move the picture 

around in your Word document, 

you need to navigate to the 

“Format Picture” option. To do so, 

either double-click on the picture 

and select “Format Picture” or go 

to the main toolbar, find “Format,” 

and then select “Format Picture.” 

(Figure 3) In the resulting pop-up 

window, select Layout>Advanced 

Layout>In Line With Text.  

(Figure 4) These steps will provide 

you with toggle squares on each 

corner, allowing you to grab the 

corners and change the size and 

orientation of the picture. 

Figure 2

Figure 3

Figure 4
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5.	 Make sure the area that the picture 

takes up in your Word file is 

slightly larger than your molding 

paste substrate. The printed photo 

will overprint the substrate onto 

your carrier sheet—a simple piece 

of printer paper. 

6.	 Use a glue stick or double-sided 

tape to attach the dry molding 

paste substrate to the carrier paper 

in exactly the same position shown 

in the Word document. 

7.	 Insert the paper and print your 

image. 

8.	 Remove the substrate from the 

carrier paper and let it dry.

NOTE: The molding paste substrate can 

also print without a carrier sheet, just as 

you would any paper.

9.	 Once the ink is dry, cover your 

printed photograph with varnish 

to protect the image. Apply a light 

coat of varnish with a foam brush. 

Do not iron.

Finish
Once the molding paste substrate is 

printed with your photograph you 

can add it to your project. Molding 

paste substrates are thick, so adjust 

your sewing machine accordingly. 

Also, once sewn, the molding paste 

will hold the holes that the needle 

makes, so ripping out stitches is not 

an option. 

The molding paste substrate can 

be sewn onto a fabric background 

and mounted, like “The Road of 

the Imagination” or sewn together 

with others to create an even larger 

photograph, like “Pause.” It can also 

be added to mixed-media work, or 

simply framed. The ways in which you  

present this unusual fiber photograph 

are numerous; let your imagination be 

your guide. 

fiberartgoddess.blogspot.com

“The Road of the Imagination” • 12" × 18" 



Adapted from 
Quilting Arts Magazine 
April/May 2011
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USING DIGITAL IMAGERY IN 

quilted collages

by Margaret Applin “Late Spring” • 111⁄2" × 111⁄2" 
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Over the past year, I have learned 

how to work with digital layers in 

Adobe Photoshop Elements. And 

now I find that every piece of art 

I create incorporates some digital 

element. Doodles become masks 

and brushes. Flower photos become 

stamps and backgrounds. My images 

take on a new life, manipulated 

through layers, and burned through 

blending modes and filters. Through 

this experimentation and play, I also 

generate a number of images I turn 

into Thermofax screens for use in 

surface design on fabric. Photo-editing 

software is a great tool; it allows me 

to reuse my photographs to create 

unlimited personal imagery.  

Directions
Preparing your image 
1.	 Pull out your journal or some 

clean pieces of watercolor paper 

and freely create using your 

favorite tools, images, paints, 

stencils, and collage elements 

without planning or trying to 

control the finished page. The 

power of play is an important part 

of the collage process—just have 

fun with it! 

2.	 Using your preferred method, 

transfer your finished pages to 

your computer. I use both my 

scanner and my digital camera. To 

capture the truest colors with your 

digital camera, use natural light.  

3.	 Open up your artwork in your 

photo-editing software and 

experiment digitally. (See “Tips for 

Working with Adobe Photoshop 

Elements.”) 

4.	 Transfer your image to fabric 

using your preferred method. For 

my images I use iron-on transfer 

paper. When using any kind of 

transfer product, remember to flip 

the images in the computer prior 

to printing. Use pieces of fabric 

large enough to accommodate an 

expanding design. My original 

foundation pieces were cut to 

approximately 14" square.

TIP: Unless you specifically want the 

background fabric to show through your 

image, I suggest using a bright white 

silk or cotton as your foundation fabric 

so your image stays as bright as possible 

and does not get muddied by different 

colored background fabrics.  

M A T E R I A L S 

•	 Journal or watercolor paper

•	 Journaling supplies, including pens, 
pencils, paints, and ephemera

•	 Stencils and stencil brushes

•	 Computer, scanner, and digital 
camera

•	 Photo-editing software (I use Adobe® 
Photoshop® Elements.)

•	 Printer 

•	 Iron-on transfer paper

•	 Fabric (I recommend bright white silk 
or cotton.)

•	 Adirondack® Color Wash

•	 Large paintbrush

•	 Tracing paper

•	 Floral images

•	 Scissors

•	 Batting

•	 Stabilizer

•	 Sewing machine with free-motion 
capability

•	 Fabric scraps and lace

•	 Sheer fabric

•	 Embroidery scissors

•	 Heavy-body white paint

Optional

•	 Thermofax® screens

•	 Embroidery floss

•	 Embroidery needle and thread

•	 Beads, beading needle, and thread

I love summer—the colors, varieties, and textures of blooming 
flowers; the early-morning chatter of birds; and the warm days 

and nights. It’s the time of year when everything is so alive and 
filled with energy and my senses are on overload. This was the 
inspiration for my latest series of quilted collages and a journal 
cover. What started out as a few journal pages using butterfly and 
flower imagery quickly transformed into art quilts full of color and 
texture.   
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Adding color 
5.	 Add color around your transferred 

image. I use diluted Adirondack 

Color Washes with a large brush 

to obtain a watercolor look, 

intentionally leaving white space 

to create additional interest. With 

this product you can go back into 

your design with the washes at 

full strength using your brush to 

add darker, more intense values 

if desired. I usually paint on dry 

fabric, but you can always dampen 

the fabric for a different painting 

result.

TIP: The closer to the edge of your 

transferred image you paint, the more 

likely the paint might bleed underneath 

your image. This can add interest 

to your design or possibly cause 

unwelcome changes to your image. Don’t 

abandon your collage if this happens. 

You can continue to add layers to it later 

through stenciling.

6.	 Trace a simple floral motif or 

another motif onto tracing paper. 

You may need to resize the motif 

depending on how large or small 

you want it relative to your design. 

Decide where you would like to 

place the motif on your layout. I 

use this technique to capture the 

lines from my flower photographs. 

Making the collage
7.	 Cut a piece of batting and stabilizer 

the same size as your design’s 

foundation fabric. Layer your quilt 

sandwich to get ready for machine 

stitching. 

8.	 There are two ways to add  

your traced motif: by adding a 

sheer (or other fabric) layer and 

then stitching along the traced 

outline (Option A), or by simply 

stitching along the traced outline 

(Option B). Try a combination of 

both techniques to create depth in 

your collage.

Option A: Use fabric to create an 

image that appears as if it is in the 

forefront of the collage. Layer a 

piece of fabric between the tracing 

paper and your base fabric (with the 

transferred image). Stitch through 

all of the layers, gently peel off the 

tracing paper, and trim around the 

stitched lines as close as possible 

with embroidery scissors. I tend to 

use sheer fabrics for this step. In one 

of my collages, using a sheer fabric, 

I extended a butterfly image that 

was cut off in my transferred image. 

The sheer overlay on the wings 

subtly pulled the complete image up 

and out of the original transferred 

image on the collage, reducing the 

obvious line between the image 

transfer and the background. 

Continue with this technique until 

you are satisfied with your design.

Option B: Stitch the design 

directly to your base fabric without 

an additional piece of fabric 

sandwiched in between. Remove 

the tracing paper template and 

use heavy-body white paint and 

a paintbrush to lightly define the 

stitch-drawn image. The white paint 

creates a ghostly feel, allowing the 

image to be defined, yet recede into 

the background.

TIP: Applying screen prints at this 

point is an alternative to tracing and 

transferring motifs. You can still free-

motion stitch through the paints or dyes 

used.

tips for

working with 
Adobe Photoshop 

Elements
Here are a few techniques I use 
with my photo-editing software. 
Remember to start by creating a 
copy of your image to use for further 
manipulation.

•	Layer your new images with other 
images containing text; or type 
directly on top of your images.

•	Layer more than one of your new 
images together; or create a larger 
digital collage using a variety of 
new or old images.

•	Change the hue and saturation 
of your images and move them 
around to see how their position 
changes the effect.  

•	Adjust the opacity of one or more 
of the layers to see how the effect 
changes.

•	Use brushes or text to layer other 
elements over your images.  

•	Use masks to create distressed 
edges. Masks are great because 
they reduce the sharp edges of 
the image against the foundation 
fabric, which helps the image 
blend into the background.

•	Build photos with a lot of texture 
into your layers and play with 
the blending modes to create 
a distressed look. Try filters to 
further transform the look and 
feel. 

•	Select a few images that stand 
out and crop them into smaller 
sections to transfer to fabric. 
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Adding more layers 
By working light to dark, and using a 

variety of surface design techniques, 

you can easily create depth through 

layers on your art-quilted collages. 

Also, by working on more than one 

collage at once, a similar look and feel 

will develop and the finished collages 

will tell a story you weren’t aware of 

while developing your art-quilt pieces. 

1.	 Incorporate fabric scraps into 

your collage to effectively add 

layers and help blend the layers. 

Try to choose fabrics that don’t 

overpower your current design; 

instead, select fabrics that subtly 

complement your design.

2.	 At this stage, stencil to blend the 

edges and to help blend the fabric 

scraps into your design. Don’t 

stray too far from the colors of 

 “Height of Summer” • 111⁄2" × 111⁄2" 
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the background fabric. A couple 

layers of subtle blending are more 

effective than one layer of a bolder 

color. Blend the stenciling over 

both the transferred image and 

background fabric to pull them 

together and reduce any obvious 

straight lines.  

TIP: When stenciling, use a light hand 

and a small amount of paint on your 

stencil brush. You can always add more 

paint, but it’s hard to remove what’s 

already been applied to the fabric.

3.	 Take a step back from your collage 

for a different perspective. If your 

stenciling tends to be heavier in 

one place than another, go back 

in to balance the overall design. 

Screen printing can be substituted 

or used in conjunction with 

stencils during this step.  

4.	 Add a second blending layer 

of stenciling if you wish, using 

a different shade of one of the 

colors taken directly from your 

transferred image. Again, subtle is 

better to encourage the blending 

process. If there is an area of your 

image where too much color bled 

under your image, add stenciling 

over this area in a color that’s 

lighter than the background. If too 

much contrast is created, stencil 

a little more with a paint color 

between the one you first used 

and the background color you are 

trying to blend into.

Adding embellishment 
1.	 Add hand embroidery as you wish. 

I tend to use it lightly or in small 

sections. For my designs, I added 

French knots in places, chicken 

scratch stitches, and tiny flower 

shoots. I chose darker colors for 

the embroidery floss and thread 

so this layer would appear closer 

than other pieces within the layers. 

The final layer should pop off the 

collage, helping to anchor the 

depth created.

2.	 Incorporate beading for added 

texture and sparkle. I chose to use 

the smallest beads so they wouldn’t 

overwhelm the design but would 

still create a layer of additional 

texture. On one collage, I used 

small metallic beads to frame the 

image. Depending on the colors 

and fabrics you select, you may 

choose to incorporate more beads 

of different sizes and colors.

Finishing 
1.	 Mount your quilted collage on 

a temporary mount. This allows 

the collage to be reused without 

damaging it. I temporarily mount 

my collages on heavy cardboard 

with heavy-duty tape and create 

a mount on the back side for 

hanging. This creates the option 

of using my collages in a different 

format later on, such as for a 

pillow or tote bag.   

2.	 Once the finished collage is 

mounted, go back into the design 

with stenciling once more to add 

interest along the edges of the 

collage to help pull the design 

together. Again, stenciling should 

be intentionally subtle so as not to 

draw the eye away from the central 

image and other layered details.

Remember to play, experiment freely, 

and enjoy the process! 

margaretapplindesigns.com

Journal 
12" × 81⁄2" × 2" 
“The cover of this 

journal was created 
through the process 

described in this 
article. There are three 
signatures sewn into a 

painted canvas cover. I 
attached my art-quilted 

collage to the front of the 
journal with machine 

stitching. I chose to 
machine baste the pages 
into the journal so that I 
can easily remove pages 

to work on outside the 
journal and then re-

stitch the pages in once 
finished. The pages of the 
journal were all painted 

using diluted Adirondack 
Color Washes, with some 
Lumiere® metallic paints 

mixed in to make the 
pages glimmer.”


